IBM Campaign
Version 9 Release 1
October 2015

Release Notes

IBM
Before using this information and the product it supports, read the information in "Notices" on page 29.
# Contents

Chapter 1. IBM Campaign v9.1.0 system requirements and compatibility .......................... 1
Browser behavior in IBM EMM products ...................................................... 1

Chapter 2. New features and changes in IBM Campaign v9.x .............................................. 3
New features and changes in IBM Campaign v9.1.0 .................................. 3
New features and changes in IBM Campaign v9.0.0 .................................. 6

Chapter 3. Fixed defects in IBM Campaign ................................................................. 11

Chapter 4. Known issues in IBM Campaign ........................................................................ 13

Chapter 5. Known limitations in IBM Campaign 9.1.0 .................................................. 17

Chapter 6. IBM Campaign Reports Package ................................................................. 21

Chapter 7. IBM Campaign documentation roadmap ......................................................... 25

Before you contact IBM technical support .................................................................... 27

Notices ........................................................................................................................... 29
Trademarks ...................................................................................................................... 31

Privacy Policy and Terms of Use Considerations ......................................................... 31
Chapter 1. IBM Campaign v9.1.0 system requirements and compatibility

IBM® Campaign is part of the IBM EMM suite of products. Campaign version 9.1.0 requires Marketing Platform 9.1.0.

For best results, set your screen resolution to 1440 x 900 or higher. Lower resolutions can result in some information not being properly displayed. If you use a lower resolution, maximize the browser window to see more content.

Where to find complete system requirement and compatibility information

For a list of IBM EMM product versions compatible with this product and a list of third-party requirements for this product, see the Recommended Software Environments and Minimum System Requirements document. This document is posted under Detailed System Requirements on the IBM Support Portal website: (http://support.ibm.com).

Note: To access the IBM EMM documentation from the Support Portal, you must log in with an IBM account. This account must be linked to your IBM customer number. To learn more about associating your account with your IBM customer number, see Support Resources > Entitled Software Support on the Support Portal.

You can also access this document by selecting Help > Product documentation when you are logged in to IBM EMM.

Installation and upgrade

You can upgrade to Campaign 9.1.0 (including eMessage) from versions 8.5.x, 8.6.x, or 9.0. If you have a prior version of Campaign or eMessage, follow the upgrade paths that are described in the IBM Campaign Upgrade Guide.

The default top-level directory for IBM EMM installations is /IBM/EMM (for UNIX) or C:\IBM\EMM (for Windows). The product installers place product files in individual subdirectories under the EMM directory. For more information, see the IBM Campaign Installation Guide or the IBM Campaign Upgrade Guide.

The response file of each product installer includes the version number.

Browser behavior in IBM EMM products

IBM EMM products have certain browser restrictions and requirements.

Supported browsers

For a list of supported browsers, see the IBM Enterprise Marketing Management Recommended Software Environments and Minimum System Requirements for version 9.1.0.
**Pop-up blockers**

You must disable any pop-up blockers in your browser or browser add-ons, such as toolbars. Pop-up blockers prevent the flowchart window from opening.

**Navigation methods**

Do not use the browser controls to navigate. For example, avoid using the browser’s Back and Forward buttons. Instead, use the controls supplied in the IBM EMM user interface.

**Using multiple browser windows in Internet Explorer**

This restriction applies to using Internet Explorer (IE) with IBM Campaign or any module that uses Campaign flowcharts (eMessage, Contact Optimization, Interact, Distributed Marketing).

To log in multiple times to view side-by-side information, you must open IE and log in to IBM EMM. Then select **File > New Session** in the IE menu bar. In the new IE browser window, log in to IBM EMM as the same or a different user.

**Important:** Do not use any other method to open multiple sessions. For example, do not open a new tab; do not open another browser session from the Start menu or desktop icon; and do not use **File > New Window** in IE. These methods can corrupt information that is shown in the application.

For details, see the *IBM Campaign User’s Guide*. 

---

**IBM Campaign: Release Notes**
Chapter 2. New features and changes in IBM Campaign v9.x

IBM Campaign version 9.x includes the following new features and changes.

- “New features and changes in IBM Campaign v9.1.0”
- “New features and changes in IBM Campaign v9.0.0” on page 6

New features and changes in IBM Campaign v9.1.0

IBM Campaign version 9.1.0 includes the following new features and changes.

IBM EMM installation and upgrade improvements

The improvements to the installation and upgrade process include:

- Installation guides for all products have been rewritten and reorganized into separate installation and upgrade guides, to make information easier to find and use.
- The installers have been enhanced to include better descriptions of the information you need to enter and to clarify what steps to take during each stage of the installation.
- Each installer now provides links directly to the product installation and upgrade guides, in either PDF or HTML formats.

IBM eMessage offer integration

Customers who license both IBM Campaign and IBM eMessage can now benefit from full offer lifecycle capability from IBM Campaign to IBM eMessage.

The new functionality allows customers to create offers in IBM Campaign, relate them to an asset in IBM eMessage, send the mailings, and automatically track the contacts (bounces are subtracted). The results are written to the Contact History tables. In addition, responders (those who click links in emails), are automatically tracked and recorded in the Response History tables.

Using IBM Campaign reporting, users can now track the full cycle for offers and see ROI data in a campaign performance report for IBM eMessage related emailings.

To configure the integration, see the IBM Campaign Administrator’s Guide.

IBM SPSS® Modeler Advantage Enterprise Marketing Management Edition integration

IBM Campaign introduces support for a new predictive analytics offering in the Campaign family, called IBM SPSS Modeler Advantage Marketing Edition, planned for availability in December 2013.

IBM SPSS Modeler Advantage Marketing Edition is for users who want to incorporate statistical modeling capabilities into their IBM Campaign management solution.
IBM SPSS Modeler Advantage Marketing Edition is based on IBM Analytical Decision Manager, part of the SPSS sophisticated predictive analytics suite, including components of SPSS Modeler and IBM SPSS Collaboration and Deployment Services.

IBM SPSS Modeler Advantage Marketing Edition provides best-in-class automation, intelligent modeling, and integration with campaign management. It provides predictive analytics for building response, customer valuation, cross-sell or market-basket association models, as well as clustering models. It requires and is fully integrated with the IBM Campaign management solution.

With IBM Campaign, you can build and maintain your models over time, as well as use these models to score data in your customer database and apply those scores for more effective marketing. By targeting customers or prospects that are more likely to respond to a particular offer, or predicting the lifetime or potential of a client, you can increase the ROI of your marketing campaigns.

For more information, see the IBM Campaign and IBM SPSS Modeler Advantage Marketing Edition Integration Guide.

**New configuration property: overrideLogToHistory**

A new configuration property, `overrideLogToHistory`, was added to `Campaign | partitions | partition[n] | server | flowchartConfig`.

This property provides the ability to ensure that contact history is always recorded during production runs.

Administrators can use this property with `logToHistoryDefault` to specify whether users are allowed to override the Log to Contact History setting when configuring a Mail List, Call List, or Track process.

If an administrator enables `logToHistoryDefault` (which causes Log to Contact History to be set in a Mail List, Call List, or Track process) and disables `overrideLogToHistory`, then all new flowcharts that are created from that point will have Log to Contact History set. As a result, all flowchart production runs will always write to contact history.

This prevents data loss during important production runs. For example, it avoids the situation where a user clears the Log to Contact History setting and then forgets to re-enable it.

**Note:** For upgrades, the value of Log to Contact History for a particular flowchart is retained as it was before the upgrade, and the ability of users to change the value depends on the permissions that are assigned to the user.

Configuration properties are described in the IBM Campaign Administrator’s Guide.

**New configuration property: disallowAdditionalValForOfferParam**

A new configuration property, `disallowAdditionalValForOfferParam`, was added to `Campaign | partitions | partition[n] | server | flowchartConfig`. 
Use this property to disallow users from selecting values other than the ones provided for a drop-down list when users configure a contact process. This property affects the behavior of all drop-down lists in contact processes (Mail List, Call List).

For example, if a Mail List process includes a credit card offer, and the offer is defined to provide a list of terms:

- If `disallowAdditionalValForOfferParam` is true, users are restricted to selecting values from the drop-down list.
- If `disallowAdditionalValForOfferParam` is false, users can select values outside of the list, for example from a database table.

Configuration properties are described in the IBM Campaign Administrator’s Guide.

**New configuration property: numRowsReadToParseDelimitedFile**

A new configuration property, `numRowsReadToParseDelimitedFile`, was added to Campaign | partitions | partition[n] | server | internal.

This property is used for table mapping of delimited files and is also used by the SPSS Score process box when importing a score output file from IBM SPSS Modeler Advantage Marketing Edition. To import or map a delimited file, Campaign must parse the file to identify the columns, data types, and field (column) widths. By default, Campaign examines 100 lines (the first and last 50) of a delimited file. In most cases, this is sufficient to determine field widths, and Campaign allocates a width based on the largest value it finds within those lines. However, in very large delimited files, a later field might exceed the estimated length, which can cause an error. Therefore, if you are importing or mapping a very large file, you can increase this value to parse a larger number of lines. For more information, see the Campaign Administrator’s Guide. Configuration properties are described in the IBM Campaign Administrator’s Guide.

**Alert users of offer deletion**

When users attempt to delete offers or folders that contain offers, automatic verification is done if any of the offers are still active. In the following cases, an offer or offer list is considered to be active:

- Contact history is populated for the offer or offer list.
- The offer is assigned to a campaign using the Add/remove Offers link (CH may/may not be populated).
- An offer LIST is assigned to a target cell spreadsheet (CH may/may not be populated).
- An offer LIST is assigned in a Mail List process but the Mail List process did not run.
- An offer LIST is assigned in a Mail List process and the Mail List process ran with "Log to CH" off (CH is NOT populated).

In the following cases, an offer or offer list is NOT treated as active:

- The offer is used in an offer list (CH is NOT populated).
- The offer is assigned to a target cell spreadsheet (CH is NOT populated).
- The offer is assigned in a Mail List process but the Mail List process did not run (CH is NOT populated).
• The offer is assigned in a Mail List process and the process ran with "Log to CH" off (CH is NOT populated).
• An offer LIST is assigned to a campaign using the Add/remove Offers link.

Important: If you attempt to delete an active offer or offer list, a confirmation message indicates that the offer or offer list will be retired instead of deleted. To prevent further use of offers or lists that are referenced in system tables, you should retire rather than delete them.

Support data filtering on the Audience process

In addition to supporting data filtering on top level Select and Extract processes in a campaign flowchart, the same functionality has been added to top level Audience processes. This was not available in previous releases of IBM Campaign.

Note: Data filters do not apply to raw SQL queries or to custom macros that use raw SQL nor when profiling for values.

New browser support

Version 9.1 adds support for Safari (Macintosh) and Internet Explorer 10 (Windows). For details, see the Recommended Software Environments and Minimum System Requirements for IBM Enterprise Marketing Management version 9.1.0.

Clear button added to Contact History Logging Options dialog

A Clear button has been added to the Contact History Logging Options dialog, which is available when configuring a Call List or Mail List process. The Clear button lets you set the Contact Date (Flowchart run date will be used if empty) field back to its default value (empty). Use the Clear button if you selected a contact date but then decide to use the flowchart run date instead.

OK and Apply button behavior

If a dialog box is opened in Campaign and you do not make any changes, the OK and Apply buttons are not active. The buttons are active only if changes are made. Previously, the buttons were active even if no changes were made. If you want to close the dialog without making changes, use the Cancel button or close the dialog by clicking X.

Connection lines in flowcharts

Connection lines that cross over another process box in a flowchart are shown on top of that process box in order to clearly indicate how processes are connected. This is a change from the way connection lines were displayed in pre 9.x versions. Flowchart designers can reposition processes in the flowchart to avoid crossed connection lines.

New features and changes in IBM Campaign v9.0.0

IBM Campaign version 9.0.0 includes the following new features and changes.

Branding

The Unica® name is no longer used. For example, IBM Unica Campaign was renamed IBM Campaign.
IBM Coremetrics was renamed Digital Analytics.

Utilities

The ActiveX cleanup utility (uacflchk) is no longer supplied, as it is no longer needed.

There is a new IBM Marketing Platform utility, alertConfigTool, which registers alerts and configurations for IBM EMM products. For details, see the IBM Campaign Installation Guide.

Configuration

There is a new configuration property (Settings | Configuration | Campaign | Partitions | partition[n] | dataSources | DefaultTextType) for ODBC data sources. This property tells IBM Campaign how to create text fields in the destination data source if the source text fields are from a different data source type. For more information, see the IBM Campaign Administrator’s Guide. (TT DOC00628)

A new configuration property was added (Affinium | Campaign | partitions | partition[n] | server | flowchartConfig | legacyMultifieldAudience). In most cases, you can leave this property set to the default value of FALSE. Campaign v8.5.0.4 and newer name multifield Audience ID fields according to the audience definition, regardless of the source of the fields. When you configure processes to use multifield Audience ID fields, you now see the new Audience ID naming convention for multifield audiences. Already-configured processes in flowcharts created in previous Campaign versions should continue to work. However, if old flowcharts fail because of the change in the naming convention, you can revert Campaign behavior by setting legacyMultifieldAudience=TRUE. (RTC 5219 DEF063741)

The Campaign | Server | fullContextPath property is now used to specify the URL that Campaign flowcharts use to communicate to the application server Listener proxy. This property is undefined by default, which causes the system to determine the URL dynamically. When the Marketing Platform is integrated with the IBM Tivoli® web access control platform, you must set this property to the Campaign URL in Tivoli.

Flowcharts

Beginning with version 9.0, the flowchart workspace was redesigned to change the look and feel and improve usability. The framework is now based on a Dojo component, Dojo Diagrammer, instead of Active-X. ActiveX, supported only in Internet Explorer, requires downloading a plug-in control on the client to work with flowcharts. Because many customers are not comfortable downloading plug-ins, and because ActiveX will not be supported in future versions of Internet Explorer, the Dojo component has been introduced to provide the flowchart workspace going forward.

The redesign includes changes to the appearance of flowchart and report components, including toolbars, dialog boxes, progress indicators, and related controls. The overall functionality is the same.

The flowchart window looks similar to the following example:
The following list summarizes the changes:

- **Separate flowchart window.** When you create or edit a flowchart, a separate flowchart window opens. Be aware of the following features of the new flowchart window:
  - When you click the flowchart tab in the main Campaign window, the main window contains a link that says "The flowchart is open in another window. Click here to display it." If you click the link while the flowchart window is already open, the flowchart window is activated. If you have closed the flowchart window, clicking this link reopens the flowchart in View mode.
  - Pop-up blockers prevent the flowchart window from opening. You must turn off any pop-up blockers in your browser or browser add-ons, or set up a specific exception for the Campaign server.
  - You can move and resize the flowchart window up to the size of your screen. You can also work in the main Campaign window while the flowchart window is open.
  - You can have only one flowchart window open at a time. If you open or edit a different flowchart while a flowchart is already open, the new flowchart will replace the current flowchart in the open window. If you have unsaved changes in the current flowchart, you will be prompted to save them before the new flowchart opens.

- **New toolbar icons.** The toolbar contains updated icons, and also contains a number of new options to provide added control over the flowchart and its appearance.

- **Process box updates.** The process boxes on the palette have updated icons to make them easier to identify and select.

  Connect process boxes by drawing a line from any of the four connection points that are visible on the process box (left, right, top, or bottom), instead of being restricted to the center of the process box as in the ActiveX control.
Note: Contrary to prior releases, not all process boxes and dialogs that use the new look and feel are resizable. This is addressed in Campaign fix pack 9.1.0.2.

- **Drag and drop.** True drag and drop is supported, so you can drag any process box from the palette to the workspace, instead of clicking in the workspace.

- **New flowchart viewing and editing tools.** The flowchart window no longer uses the grid-based layout of the ActiveX control. Instead, you can move process boxes freely, and place them anywhere on the flowchart. For that reason, new tools are available to adjust flowchart appearance when a flowchart is open for editing or viewing:
  - Use the alignment options on the toolbar to align two or more selected process boxes: Align left, Align right, Align top, Align bottom, Align center vertical, Align center horizontal. The grid of gray dots is no longer used because alignment options are provided.
  - Use the Change Layout options on the toolbar to apply a predefined layout to your flowchart: Tree, Org Chart, Circular, Hierarchical.
  - Use Zoom In, Zoom Out, and Reset Zoom on the toolbar to improve the visibility of portions of the flowchart. You can also use the Control key on your keyboard while using the scroll wheel on your mouse to zoom in and out.
  - Use Fit Contents on the toolbar to resize the flowchart to fit in the workspace. Then, if needed, use the Zoom options or the panning box to further refine the view.
  - Use Search on the toolbar to find a process box by name in the flowchart. The search tool is not case sensitive. When a search result is found, the matching process box is centered in the flowchart window and highlighted. Click the Search icon again to continue to the next match.
  - Use Select All on the toolbar to select all process boxes in the flowchart.
  - Use the panning box in the lower right corner of the flowchart window to highlight the area that you want to see. Panning is especially useful in flowcharts with many process boxes.

- **Running flowcharts.** The new flowchart window provides new icons for the run states for a process box, most notably the icons indicating that the flowchart is running, indicated by an animated icon, or paused, providing a status icon that was not available with the ActiveX control.

- **Dialog box enhancements.** The dialog boxes in the flowchart, especially for configuring process boxes, have been improved in this release. Some of the changes include the following modifications:
  - The behavior of lists in some dialogs has changed. For example, you can use `Ctrl+click` to select multiple items. Lists that can be expanded are now indicated by a small arrow next to the list, instead of a plus sign (+).
  - The appearance of process dialog boxes has been updated to improve their usability, while keeping the layout and functionality similar to past releases.
  - You no longer need to use a separate edit field to modify cell values in a grid in process box dialogs. Double-click any cell to edit it.

- **New export options.** There are changes to how you export profile data after you profile a field in a process. Previously, data was exported to XLS and the file name was hardcoded to “Campaign.xls”. Now data is exported to CSV (comma-separated values) format. Use the **File name** field to assign a file name. The default name is the dialog box title, "Export Report Data".

For information about the new and changed features, see the following topics in the *IBM Campaign User’s Guide*: 

Chapter 2. New features and changes in IBM Campaign v9.x
• Flowchart workspace overview
• Working with process boxes
• Changing flowchart appearance

To get help when a flowchart is open for editing, click the help icon in the flowchart window toolbar.

Reports

Some changes were made to report appearance. For example, the legend at the top of cell reports was improved to be more legible.

The Cell Waterfall report now lets you specify which path in the flowchart to analyze, if the selected cell is connected to multiple downstream processes. Use the Path list in the report toolbar to select a path to analyze.

Information about installing, upgrading, and configuring reports is no longer in the IBM Campaign documentation. This information is now consolidated in a new guide, IBM EMM Reports Installation and Configuration Guide.

Table mapping

With the replacement of the ActiveX control with a Dojo-based user interface, the Table Mappings dialog has been updated and enhanced. The essential functionality is the same, but the Save and Load mappings controls have been replaced by drop-down lists, as shown in the following example:

Additional changes

The Russian language is now supported. For information about setting locale preferences, see the IBM Marketing Platform Administrator’s Guide.
Chapter 3. Fixed defects in IBM Campaign

The following table lists defects that were fixed in Campaign 9.1.0, sorted by defect number.

Table 1. Campaign fixed defects

<table>
<thead>
<tr>
<th>Issue</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connections between process boxes may overlap when user switches from</td>
<td>2980</td>
<td>When users switch between horizontal and vertical view modes, the connection lines and processes may overlap.</td>
</tr>
<tr>
<td>horizontal to vertical mode</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caching in DOJO displays the wrong information until the process</td>
<td>6141</td>
<td>Until a process box loads completely, previous information, or information pertaining to the previous process box displays in the background. When the loading of all data is done, the screen is refreshed and shows the most up to date data.</td>
</tr>
<tr>
<td>box information is completely loaded</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Grid borders are not displayed wherever data is not present.</td>
<td>6692</td>
<td>In certain process boxes, if no data is present in a grid column, the borders around the cell in the grid are not displayed.</td>
</tr>
<tr>
<td>If contact date is year 2050 then the Optimize process box shows</td>
<td>6910</td>
<td>Contact date cannot be later than 2037.</td>
</tr>
<tr>
<td>error 10404: unable to communicate with server process; server process</td>
<td></td>
<td></td>
</tr>
<tr>
<td>might have exited.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User cannot see complete 3D Graph in the report window</td>
<td>8036</td>
<td>Due to maximization limits on the report window, the entire 3D report cannot be shown in one window without scrolling.</td>
</tr>
<tr>
<td>Process boxes overlap on flowchart window</td>
<td>8603</td>
<td>In certain scenarios, processes might overlap one another.</td>
</tr>
<tr>
<td>A deleted flowchart tab might continue to display</td>
<td>8955</td>
<td>A deleted flowchart tab displays until the campaign or session is revisited again in a specific condition.</td>
</tr>
<tr>
<td>The Offer and Control-Cell columns for Control Cells do not display</td>
<td>9163</td>
<td>On the treatment tab of the Maillist or Calllist process, columns related to the Control cells and related offers are not greyed-out. You cannot add offers for control cells, so the columns should be disabled.</td>
</tr>
<tr>
<td>as disabled on the Treatment Tab of the Mail List.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrade does not put correct information in setenv.bat for</td>
<td>9359</td>
<td>When running the Campaign upgrade scripts, there is a pointer in &quot;setenv.bat&quot; to the platform home directory. UNICA_PLATFORM_HOME must be set to run acUpgradeTool. If it is not set, the user is prompted to provide the path while running the tool.</td>
</tr>
<tr>
<td>Marketing Platform</td>
<td></td>
<td>If the Marketing Platform is installed on a different machine from Campaign, the path of platform home is not accessible to the upgrade tool. To continue, the user must enter another accessible path for platform home. This can be in any directory.</td>
</tr>
<tr>
<td>JS error displayed when click OK on Treatment tab in Maillist PB</td>
<td>11416</td>
<td>An error no longer occurs in this situation.</td>
</tr>
<tr>
<td>Users can specify the table field by manually entering a string in</td>
<td>33832</td>
<td>When the configuration property disallowAdditionalValForOfferParam is True, users should not be able to select any Table Value/UCGF/Derived Field in the Value drop-down of any parameter on the Mail List process Parameters tab for any offer attribute.</td>
</tr>
<tr>
<td>the value drop-down of the Parameters tab even when disallowAdditionalValForOfferParam is set.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue</td>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
<td>-------------</td>
</tr>
<tr>
<td>Schedule fails if flowchart renamed/moved and it has one schedule completed</td>
<td>062623 TT</td>
<td>The flowchart schedule fails with Error 701 if the flowchart is renamed or moved and it has one schedule completed.</td>
</tr>
<tr>
<td>Error “10490 Json data received from web app has datatype mismatch” on OK button of Sample PB.</td>
<td>72644</td>
<td>If you click OK or select another tab after specifying the number of samples or segments in the Sample process box, the following error message appears: &quot;10490 Json data received from web app has datatype mismatch&quot;. The workaround is to click OK again or select the tab a second time.</td>
</tr>
</tbody>
</table>
# Chapter 4. Known issues in IBM Campaign

The following table lists known issues in Campaign 9.1.0, sorted by defect number.

<table>
<thead>
<tr>
<th>Issue</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail List process box gets unconfigured with error '31606:History table are changed' on Flowchart run.</td>
<td>NA</td>
<td>1. There is no issue if the history tables are mapped prior to building a flowchart and adding a Mail List process. 2) If you do not follow step 1, you can still map the history tables after the error appears. If you edit the flowchart and configure the process box, the process will run.</td>
</tr>
<tr>
<td>Message when running installer in UNIX console mode</td>
<td>NA</td>
<td>When running the installer in UNIX console mode, an informational message indicates that the installer .bin file was not found. You can ignore this message.</td>
</tr>
<tr>
<td>Unable to open flowcharts after migrating non-ASCII data</td>
<td>NA</td>
<td>After migrating non-ASCII data to Campaign 8.6, in some cases you cannot open Campaign flowcharts on the target system. Session flowcharts open successfully. To work around this issue, remigrate the campaigns in overwrite mode. You can then open the flowcharts.</td>
</tr>
<tr>
<td>Hot keys are not implemented on most of the windows</td>
<td>2968</td>
<td>In the Dojo implementation it is not possible to use keyboard shortcuts to activate certain functions. Instead the user must click buttons.</td>
</tr>
<tr>
<td>Nodes swap places in a Select process box</td>
<td>7275</td>
<td>When you select a derived field in a Select process, then close the Derived Fields dialog, the User Variables and Derived Fields items change position in the list of Available Fields.</td>
</tr>
<tr>
<td>Incorrect report displayed for cells which have not yet run.</td>
<td>7844</td>
<td>For cells which have not yet run, the report for the previous cell displays.</td>
</tr>
<tr>
<td>The server might crash when running the Collect Flowchart data functionality.</td>
<td>8019</td>
<td>If a text value is entered in the date field on the Collect Flowchart data functionality, the server process might crash.</td>
</tr>
<tr>
<td>Summary file option in MailList should be disabled when Export to File is unchecked.</td>
<td>13460</td>
<td>When the Export to File option is unchecked on the Fulfillment tab of the Mail List process box, the Summary File option is enabled but should not be.</td>
</tr>
<tr>
<td>There should be a way to map DCH from UI when field name for CH table is changed.</td>
<td>13502</td>
<td>There should be a way to map the UA_DtlContactHistory table after changing a column name in the UA_ContactHistory table. To map UA_DtlContactHistory, change the source table's column name accordingly (so the Source Table fields and Required Fields match) and then map the table.</td>
</tr>
<tr>
<td>Warning message about offer being used in List appears twice while deleting active offers.</td>
<td>36267</td>
<td>The message &quot;WARNING: The &quot;Offer Offer1&quot; offer(s) has been used in one or more offer lists. Deleting this offer will automatically remove it from these offer lists. Do you want to continue?&quot; appears twice.</td>
</tr>
<tr>
<td>Problem displaying currency with 3 decimals in Offer UI.</td>
<td>57901</td>
<td>Template with parameterized attribute shows three decimal places. After saving an offer, only two decimal places appear.</td>
</tr>
<tr>
<td>Information related to associated products does not appear in offer on Marketing Operations.</td>
<td>TT DEF062333</td>
<td>When an offer created in Campaign with products associated with it is imported in Marketing Operations, information about the associated products is not available in Marketing Operations.</td>
</tr>
<tr>
<td>Issue</td>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If it was not mapped initially, the Digital Analytics translation table is not available in the Segment process box.</td>
<td>TT DEF063392</td>
<td>No translation table or any other user table is available in the Segment process box, if the translation table was not mapped initially.</td>
</tr>
<tr>
<td>Date handling with Oracle for offer templates with very old dates.</td>
<td>65446</td>
<td>Offer templates that contain very old dates (such as 214) cannot be saved. An exception occurs stating that the supplied value is not a valid instance of data type datetime.</td>
</tr>
<tr>
<td>The defined decimal places in a custom attribute are ignored in Maillist.</td>
<td>66057</td>
<td>Using an Offer Custom Attribute in a Mail List, the number of decimal place specified in the Custom Attribute definition are ignored.</td>
</tr>
<tr>
<td>Select PB fails with Error 11528 when configured using a Custom macro created based on Dimension Table.</td>
<td>71062</td>
<td>A custom macro that is based on a dimension table can result in process errors, such as Error 11528 for a Select process, because the custom macro base table name is prepended to the selected field name, along with the dimension table name.</td>
</tr>
<tr>
<td>Difficult to assign a control cell to a target cell on Treatment tab of Mail List process if offer is assigned first to the target cell.</td>
<td>71065</td>
<td>When you click the control cell grid cell to assign a target cell, the target cell select becomes a small thin line which makes it difficult to select. This only happens if you assign a control cell to a target cell that is at the top of the dialog. Click again in the dialog and the drop-down list will appear.</td>
</tr>
<tr>
<td>Clicking &quot;Return to previous page&quot; distorts the UI in some cases.</td>
<td>75262</td>
<td>Use the links within the products to navigate in IBM EMM products, rather than the browser controls.</td>
</tr>
<tr>
<td>Unnecessary \re is added for PLATFORM_CLASSPATH in setenv.sh for upgrade from 8.5+To9.1.</td>
<td>80929</td>
<td>This does not impact the upgrade because the PLATFORM_CLASSPATH variable is no longer used by the upgrade.</td>
</tr>
<tr>
<td>SPSS Model PB is failing with error 18009.</td>
<td>81309</td>
<td>This issue occurs only with models that have fewer than 20 records.</td>
</tr>
<tr>
<td>Campaign Upgrade Logs shows error related to Optimize in the log files.</td>
<td>90944</td>
<td>When upgrading, if you see the following warnings, you can ignore them, as they are harmless: WARN upgradeTool.AC80UpgradeTask [1014] - Unable to find param: Affinium \ Campaign \ partitions \ partition1 \ Optimize \ DisplayFormat WARN upgradeTool.AC80UpgradeTask [1028] - Unable to find param: Affinium \ Campaign \ partitions \ partition1 \ Optimize \ AlgorithmTuning \ ConflictPredictionPercentage</td>
</tr>
<tr>
<td>Even if no changes are done to the Extract PB a message &quot;Process run results will be lost, Continue ?&quot; is displayed.</td>
<td>90956</td>
<td>If you open an Extract process configuration dialog and click OK without making any changes, this message appears. The message should not appear when no changes have been made.</td>
</tr>
<tr>
<td>Campaign and Interact upgrade script.</td>
<td>90970</td>
<td>Unwanted class name is displayed on upgrade script execution: &quot;com.ibm.net.SocketKeepAliveParameters&quot;. There is no impact on functionality. You can ignore these messages.</td>
</tr>
<tr>
<td>ETL log does not use actual table names.</td>
<td>93872</td>
<td>Unmapped tables cause the ETL to fail and exceptions to be written to the ETL log file. The audienceid is appended to the table name in the log.</td>
</tr>
</tbody>
</table>
### Table 2. Campaign known issues (continued)

<table>
<thead>
<tr>
<th>Issue</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error when changing the model Type from Predictive to Association.</td>
<td>93877</td>
<td>This also occurs if you click the Data tab. Data is scanned automatically and hence on executing the SPSS Model process the results are incorrect.</td>
</tr>
<tr>
<td>Non ASCII characters are truncated from offer name.</td>
<td>93906</td>
<td>This is a display issue only. When you click Link to IBM eMessage Digital assets on the offer page to see the associated asset, non-ASCII characters are truncated from the offer name.</td>
</tr>
<tr>
<td>Campaign upgrade script execution completed with errors related to drop statements.</td>
<td>102958</td>
<td>During upgrades, there is a message “Unable to execute all SQL updates successfully, please check the log file for details.” This is related to the following drop statements and does not impact the upgrade script execution: DROP TABLE UA_OfferSuppression DROP TABLE UA_RespTypeMapping.</td>
</tr>
<tr>
<td>JS error when adding flowchart.</td>
<td>106625</td>
<td>This happens only when Interact is installed AND the option 'Display a notification about every script error' is enabled in the Browsing section of the Advanced tab for Internet Options in Internet Explorer 9 and 10. By default this option is not enabled.</td>
</tr>
<tr>
<td>Mapped table/file node not displayed in Create Derived field window launched from Extract tab of Extract PB.</td>
<td>106626</td>
<td>Workaround: Create the derived field from the Source tab of the Extract process and it will be available on the Extract tab.</td>
</tr>
</tbody>
</table>
# Chapter 5. Known limitations in IBM Campaign 9.1.0

The following table lists known limitations in Campaign 9.1.0.

## Table 3. Campaign known limitations

<table>
<thead>
<tr>
<th>Issue</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialog behavior</td>
<td>NA</td>
<td>In certain cases, it is necessary to click twice in order to activate a field or change a field value.</td>
</tr>
<tr>
<td>Unused configuration property: monitorEnabledForEmessage</td>
<td>NA</td>
<td>The following configuration property is not currently used: Campaign</td>
</tr>
<tr>
<td>Relevant products limitation</td>
<td>NA</td>
<td>When offer management is performed from IBM Marketing Operations, the &quot;relevant products&quot; functionality, which relates product IDs to offers, is not available.</td>
</tr>
<tr>
<td>Blank or incorrect results from derived fields in a Mail List process. This can occur in a process box that uses a derived field that calls a Generated field (UCGF) that changes value.</td>
<td>NA</td>
<td>Do not use a UCGF in a Mail List derived field if the UCGF is not constant. Also, from the Parameters tab, do not create a derived field to call a UCGF to populate offer attributes. For details, see the following Tech Note:<a href="http://g01ziwas018.ahe.pok.ibm.com/support/dcf/preview.wss?host=g01ziidbs003.ahe.pok.ibm.com&amp;db=support/swg/istech.nsf&amp;unid=C4A93DC0ED188D6985257A6B00699C45&amp;taxOC=SSCKNRB&amp;MD=2012/08/31%2015:08:35&amp;sid=">http://g01ziwas018.ahe.pok.ibm.com/support/dcf/preview.wss?host=g01ziidbs003.ahe.pok.ibm.com&amp;db=support/swg/istech.nsf&amp;unid=C4A93DC0ED188D6985257A6B00699C45&amp;taxOC=SSCKNRB&amp;MD=2012/08/31%2015:08:35&amp;sid=</a></td>
</tr>
<tr>
<td>Windows impersonation is not working.</td>
<td>NA</td>
<td>Windows impersonation was implemented for use with ActiveX, which was replaced by the Dojo/Web client in v9.0 and later. Therefore, Windows impersonation support should no longer be needed.</td>
</tr>
<tr>
<td>Profiling a Campaign Generated Field (UCGF) does not yield correct results.</td>
<td>NA</td>
<td>Some UCGFs have a value according to the cell or the offer being processed. For cell-related UCGFs, only the value associated with the first cell appears during profiling.</td>
</tr>
<tr>
<td>The default value for a custom cell attribute does not appear when you open the Target Cell Spreadsheet.</td>
<td>NA</td>
<td>Although the default value is not initially displayed, it will be used. The value can be displayed or changed by clicking or opening and editing the custom cell attribute in the TCS.</td>
</tr>
<tr>
<td>UA_UsrResponseType.Name field cannot contain restricted string.</td>
<td>NA</td>
<td>The UA_UsrResponseType.Name field cannot contain a left parenthesis followed by a single quote.</td>
</tr>
<tr>
<td>Issue</td>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use unique TempTablePrefix for each data source when mapping multiple data sources to same physical database.</td>
<td>NA</td>
<td>If you mapped multiple data sources in Campaign to the same physical database, and you use the same TempTablePrefix for more than one of the data sources, when you use the cleanup utility to delete orphaned temp tables, it may falsely identify temp tables as orphaned, when they are in fact legitimate temp tables defined from a different Campaign data source. Any deleted temp tables will automatically be recreated when you rerun affected flowcharts, but as a best practice, use a unique TempTablePrefix for each data source when mapping multiple data sources to the same physical database. If the data sources defined in Campaign map to different schemas in the database, another solution is to ensure that the database user who runs the cleanup utility does not have privileges to drop tables in other schemas in the same database.</td>
</tr>
<tr>
<td>WebLogic 11g and AIX® 6.1 or higher</td>
<td>NA</td>
<td>If you use the combination of WebLogic 11g and AIX 6.1 or higher, a manual workaround is required to address classloading issues in WebLogic. The workaround involves removing the xercesImpl.jar file from the Campaign.war file, and repackaging it before deploying. Full details are included in the installation steps in the Campaign Installation Guide.</td>
</tr>
<tr>
<td>Unused configuration property: ShareConnection</td>
<td>758</td>
<td>The following configuration property is no longer used: Campaign</td>
</tr>
<tr>
<td>Folders without any Custom Macros are displayed under the &quot;Custom Macro&quot; node in the Formula Helper window</td>
<td>3203</td>
<td>If folders exist on a parent folder, and these folders contain no custom macros, Campaign still displays the folder.</td>
</tr>
<tr>
<td>Selected derived field under Based on drop-down of advanced setting window should open in Edit mode</td>
<td>9055</td>
<td>When clicking the button to see the details of a derived field added on the MORE section, the derived field should open in edit mode. Instead a Create Derived Field window opens. Users can select the derived field from the drop-down.</td>
</tr>
<tr>
<td>Dialog boxes cannot be resized</td>
<td>11162</td>
<td>You cannot maximize or resize dialog boxes in Campaign (for example Process Configuration or Table Mapping dialogs).</td>
</tr>
<tr>
<td>Error 19024: Cannot delete segment folder if the segment was deleted from the folder.</td>
<td>17202</td>
<td>A segment that is deleted from a folder remains as an inactive segment in the folder. Folders with inactive segments cannot be deleted. This is working as intended.</td>
</tr>
<tr>
<td>If the same flowchart is edited in multiple locales, undesired behavior can occur.</td>
<td>18991</td>
<td>This situation occurs only if two (or more) users with different language settings edit the same flowchart. Users with different locales should not edit the same flowchart that was created by a user with a different locale since this can lead to undesired behavior. The preferred approach is to create and edit flowcharts with users having the same language settings.</td>
</tr>
<tr>
<td>Issue</td>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SPSS Model cannot be built in SPSS MA from stream generated from SPSS Model process in Campaign (via Create new modeling stream).</td>
<td>50742</td>
<td>Before the SPSS Model process box has been run, the data source defined in the SPSS modeling stream is based on a dummy file of only 4 records and cannot be used for modeling interactively (from the Model tab in the SPSS GUI). The user can change the data source and model manually, or they can run the Model process which will pull the real data and populate the configured data source and then subsequently manually initiate modeling in the modeling stream.</td>
</tr>
<tr>
<td>Copy and Paste behavior in TCS</td>
<td>64710</td>
<td>You cannot copy data into the target cell spreadsheet (TCS) using Copy and Paste. For example, you cannot copy rows from an Excel spreadsheet and paste them into a TCS. This is a browser limitation for security reasons. Instead, use <strong>Import Target Cells</strong> to import data from a comma-separated values (.csv) file. To copy data out of the TCS, use <strong>Export Target Cells</strong>.</td>
</tr>
<tr>
<td>Linked cell is not highlighted after linking a cell and re-opening &quot;Link to target cell&quot; in a Segment or Sample process.</td>
<td>65815</td>
<td>A linked cell in a Segment or Sample process configuration dialog box is not highlighted in the Output Cell Name list (on the General tab). It should be highlighted to indicate that it is linked to a cell in the target cell spreadsheet (TCS).</td>
</tr>
<tr>
<td>Copy and paste behavior in process boxes and other dialogs</td>
<td>84147</td>
<td>For security reasons, some browsers do not allow applications to copy and paste via the Clipboard. This affects the General tab of the Segment process configuration and other areas of the application where copy and paste might be used.</td>
</tr>
<tr>
<td>Campaign utilities</td>
<td>161323</td>
<td>The error &quot;Login failed. Error 10553&quot; can occur if you try to log in to the Campaign utilities when the IBM Marketing Platform</td>
</tr>
<tr>
<td>Process box connection arrow changes direction</td>
<td>201968, 200241</td>
<td>If two process boxes are moved very close together in a flowchart, the direction of the connection arrow changes. This limitation affects the visual representation of the arrow. The process data flow is not affected. The workaround is to move the process boxes farther apart so the arrowhead changes back to the correct direction.</td>
</tr>
</tbody>
</table>
Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to track campaign, offer, and cell performance. To use the Reports Package, Campaign must be integrated with IBM Cognos®.

For more information, see the IBM EMM Reports Installation and Configuration Guide that is supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:

- Schemas that are registered with IBM Marketing Platform during installation. They describe the attributes and metrics that represent the product's reporting schema and include:
  - Base schemas that are the basis of the reporting schema (with no custom attributes)
  - Custom versions of most of the base schemas that rely on the preconfigured custom attributes for Campaign
  - Templates that you can use to create new schemas
- IBM Cognos customizable model and reports to be deployed on an IBM Cognos BI Server
- Reference documentation that describes the IBM Cognos model and the reports. Documentation can be found in the directory ReportsPackCampaign\cognos10\CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system tables.

Reporting Schemas

The following reporting schemas are provided:

- Campaign Views provides the standard attribute views of the Campaign system tables (campaign, offer, cell, and so on).
- Campaign Custom Attributes is for reporting on custom attributes of campaigns, offers, and cells.
- Campaign Performance is used by reports that display performance measurements starting at the campaign level over all time or various periods of time (days, months, and so on).
- Offer Performance is used by reports that display performance measurements starting at the offer level over all time or various periods of time (days, months, and so on).
- Campaign Offer Response Breakout is used by reports that show campaign and offer responses based on response types.
- Campaign Offer Contact Status Breakout is used for measurement of campaign and offer contacts based on contact status.

The custom schemas extend the last five of the listed schemas to include the default, preconfigured response types, custom attributes, and so on.
Templates

If you have additional audience levels, you can create additional reporting schemas for them with the following templates:

- Campaign Views
- Campaign Custom Attributes
- Campaign Performance
- Offer Performance
- Campaign Offer Response Breakout
- Campaign Offer Contact Status Breakout

Reports

The reports package contains Cognos example reports that can be accessed from the Analytics menu or the Analysis tab for a campaign or offer. Reports can also be displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign Analysis tab:

- Campaign Detailed Offer Response Breakout
- Campaign Financial Summary by Offer (Actual)
- Campaign Offer Performance by Month
- Campaign Performance Summary by Cell
- Campaign Performance Summary by Cell with Revenue
- Campaign Performance Summary by Offer
- Campaign Performance Summary by Cell and Offer
- Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:

- "What If" Offer Financial Summary
- Offer Performance by Day
- Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple objects in Campaign. These reports are available from the Campaign Analytics page.

- "What If" Offer Financial Summary
- Campaign Detailed Offer Response Breakout
- Campaign Financial Summary by Offer (Actual)
- Campaign Offer Performance by Month
- Campaign Performance Comparison
- Campaign Performance Comparison (with Revenue)
- Campaign Performance Comparison by Initiative
- Campaign Performance Summary by Cell
- Campaign Performance Summary by Cell (with Revenue)
- Campaign Performance Summary by Cell by Initiative
- Campaign Performance Summary by Offer
- Campaign Performance Summary by Offer (with Revenue)
The following campaign-specific example report portlets are available on dashboard pages:

- Campaign Response Rate Comparison
- Campaign Return on Investment Comparison
- Campaign Revenue Comparison by Offer
- Offer Response Breakout
- Offer Response Rate Comparison
- Offer Responses for Last 7 Days
Chapter 7. IBM Campaign documentation roadmap

IBM Campaign provides documentation and help for users, administrators, and developers.

Table 4. Get up and running

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>View a list of new features, known issues, and limitations</td>
<td>IBM Campaign Release Notes</td>
</tr>
<tr>
<td>Learn about the structure of the Campaign database</td>
<td>IBM Campaign System Tables and Data Dictionary</td>
</tr>
<tr>
<td>Install or upgrade Campaign and deploy the Campaign web application</td>
<td>One of the following guides:</td>
</tr>
<tr>
<td></td>
<td>• IBM Campaign Installation Guide</td>
</tr>
<tr>
<td></td>
<td>• IBM Campaign Upgrade Guide</td>
</tr>
<tr>
<td>Implement eMessage, if you purchased eMessage</td>
<td>• The IBM Campaign Installation and Upgrade guides explain how to install and prepare eMessage components in the local environment.</td>
</tr>
<tr>
<td></td>
<td>• The IBM eMessage Startup and Administrator’s Guide explains how to connect to the hosted messaging resources.</td>
</tr>
<tr>
<td>Implement the IBM Cognos reports provided with Campaign</td>
<td>IBM EMM Reports Installation and Configuration Guide</td>
</tr>
</tbody>
</table>

Table 5. Configure and use Campaign

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Adjust configuration and security settings</td>
<td>IBM Campaign Administrator’s Guide</td>
</tr>
<tr>
<td>• Prepare Campaign for users</td>
<td></td>
</tr>
<tr>
<td>• Run utilities and perform maintenance</td>
<td></td>
</tr>
<tr>
<td>• Integrate Campaign with Digital Analytics</td>
<td></td>
</tr>
<tr>
<td>• Create and deploy marketing campaigns</td>
<td>IBM Campaign User’s Guide</td>
</tr>
<tr>
<td>• Analyze campaign results</td>
<td></td>
</tr>
<tr>
<td>Improve flowchart performance</td>
<td>IBM Campaign Tuning Guide</td>
</tr>
<tr>
<td>Use Campaign macros</td>
<td>IBM Macros for IBM EMM User’s Guide</td>
</tr>
</tbody>
</table>

Table 6. Integrate Campaign with other products

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure eMessage offer integration.</td>
<td>IBM Campaign Administrator’s Guide</td>
</tr>
<tr>
<td>Integrate and use Campaign with Digital Analytics</td>
<td>IBM Campaign Administrator’s Guide</td>
</tr>
<tr>
<td>Integrate and use Campaign with IBM SPSS Modeler Advantage Marketing Edition</td>
<td>IBM Campaign and IBM SPSS Modeler Advantage Marketing Edition Integration Guide</td>
</tr>
<tr>
<td>Integrate and use Campaign with Marketing Operations</td>
<td>IBM Marketing Operations and IBM Campaign Integration Guide</td>
</tr>
</tbody>
</table>
### Table 7. Develop for Campaign

<table>
<thead>
<tr>
<th>Task</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop custom procedures with the API</td>
<td>• IBM Campaign Offer API Specification</td>
</tr>
<tr>
<td></td>
<td>• JavaDocs in devkits\CampaignServicesAPI</td>
</tr>
<tr>
<td>Develop Java™ plug-ins or command-line executables to add validation to Campaign</td>
<td>• IBM Campaign Validation PDK Guide</td>
</tr>
<tr>
<td></td>
<td>• JavaDocs in devkits\validation</td>
</tr>
</tbody>
</table>

### Table 8. Get help

<table>
<thead>
<tr>
<th>Task</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open online help</td>
<td>1. Choose Help &gt; Help for this page to open a context-sensitive help topic.</td>
</tr>
<tr>
<td></td>
<td>2. Click the Show Navigation icon in the help window to display the full help.</td>
</tr>
<tr>
<td>Obtain PDFs</td>
<td>Use either of the following methods:</td>
</tr>
<tr>
<td></td>
<td>• Choose Help &gt; Product Documentation to access Campaign PDFs.</td>
</tr>
<tr>
<td></td>
<td>• Choose Help &gt; All IBM EMM Suite Documentation to access all available documentation.</td>
</tr>
<tr>
<td></td>
<td>• Access all documentation during the installation process from the IBM EMM installer.</td>
</tr>
<tr>
<td>Get support</td>
<td>Go to <a href="http://www.ibm.com/">http://www.ibm.com/</a> and click Support &amp; downloads to access the IBM Support Portal.</td>
</tr>
</tbody>
</table>
Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the documentation, your company’s designated support contact can log a call with IBM technical support. Use these guidelines to ensure that your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:

• A brief description of the nature of your issue.
• Detailed error messages that you see when the issue occurs.
• Detailed steps to reproduce the issue.
• Related log files, session files, configuration files, and data files.
• Information about your product and system environment, which you can obtain as described in “System information.”

System information

When you call IBM technical support, you might be asked to provide information about your environment.

If your problem does not prevent you from logging in, much of this information is available on the About page, which provides information about your installed IBM applications.

You can access the About page by selecting Help > About. If the About page is not accessible, check for a version.txt file that is located under the installation directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This account must be linked to your IBM customer number. To learn more about associating your account with your IBM customer number, see Support Resources > Entitled Software Support on the Support Portal.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information about the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. A cookie is a piece of data that a web site can send to your browser, which may then be stored on your computer as a tag that identifies your computer. In many cases, no personal information is collected by these cookies. If a Software Offering you are using enables you to collect personal information through cookies and similar technologies, we inform you about the specifics below.

Depending upon the configurations deployed, this Software Offering may use session and persistent cookies that collect each user's user name, and other personal information for purposes of session management, enhanced user usability, or other usage tracking or functional purposes. These cookies can be disabled, but disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through cookies and similar technologies. If the configurations deployed for this Software Offering provide you as customer the ability to collect personal information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's website terms of use (e.g. privacy policy) which includes a link to IBM's and Client's data collection and use practices, (2) notify that cookies and clear gifs/web beacons are being placed on the visitor's computer by IBM on the Client's behalf along with an explanation of the purpose of such technology, and (3) to the extent required by law, obtain consent from website visitors prior to the placement of cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on website visitor's devices

For more information about the use of various technologies, including cookies, for these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/privacy/details/us/en section entitled "Cookies, Web Beacons and Other Technologies."